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Abstract

This project is designed to help people with muscle weakness (Amyotrophic
Lateral = Sclerosis, ALS) can help themselves. By using brain signals
(Electroencephalography, EEG) to facilitate the patient's muscle weakness to turn
ON/OFF electrical equipment or command devices. The project is divided into three
main parts : the first is EEG receiver (EPOC Headset) measure the electrical signals of
the brain and send to second part. In the second part, sighal processing by computer
programming then exports to output in the last part such as monitor or control

electrics devices.
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msmswﬂaulw%anaawﬂﬂmLuaqmﬂwmﬁamwmﬂmﬂaummuanmansvuaMﬁmmrﬂ‘uu
fiauusadosifiunifiniaserannsatuiinles ey mMinsramdulnihauesislianunsold
TumsitadeindUaelilidulsaaudn LLm;JU'zJ[a'Uuamqmn’iummummamaauuauum3
lvdelsmandnuardisuenviaveslsaaudn

2.1.4.2 Prwiladousnlsnszninlsrandniunisundsth (Pseudoseizure) ae
3%5%&1nT.smxijiiﬂau'ﬁ’ﬂﬁ’umiuﬂﬁﬁn gUhelsaandniivunailuasznundulnianes
ﬁm‘dﬂmana Ly ﬂmmaammmamawuawmwmLLauLmamaaLiamw Spike #38 Sharp
wave WJ"] 81 vnﬂmhau,ﬂawnﬁlvmwluwusamulw“ﬁwLUaauLLUaaLaﬂ Wi theaeilanns
Eﬂﬂmmmammwmamlﬂwmms‘un

2.1.4.3 drglumsidadelsanauss drelunsidedelsanieanss wazuen
mmua«uaawmaamw’luama wiu ilesenluaves HMuaues Tsrfnidavasszuutssam (9
AUDIBNLEY Laawmauaaamau) \denvenluanes gURmmunudAsye Tsavasnidonauawis



a aa s w . A a o a = v o
TUANNAINNITAUAU (Infarction) viTaslianlAnanviasaldanumn (Hemorrhage) aiiwunm
IvgjnouazegindiufnaueniliAnaaulnihauednunile

v = v o Vet w = A e =
2.1.44 venszauminuvesauelugiiendanuidndivasuulamiafunse

Tpai

2.1.45 theunvdiladunizanemis wWeldiunmsisutudnvasnenain
oty

2.1.4.6 AnwinisiUdsuulamwesrdulniiivesnsuaundy \iedaeitadelsai
Hedaetunisudu

2147 Famufthefimddldtueaay ielilildsuenaaumnidululusemiing
ARt

2.1.4.8 mmmnwﬂmwummsmwmfa Lwammmmmnﬂmnmmwmﬂﬂm‘uaq
am’meﬂmmnwmaamw‘luauawmbmamn Luaqfa'1ﬂUwﬂﬂwmwuwsnﬁamwmaaaum
ma‘hﬂamnawLLammmimawqmﬂssmawﬂuwwmwmml@ Ly wfaawlmummmu
mwumamumaﬂmmaummaLLammmsﬂswmwaawiammwaqwm vieithelsaaudn
Tuvauedn aT«mwqmnﬁmmﬂaau‘lmwam agluvinlaviwilsunug Ssennisfsndniiniy
AeugUen1adnnTEn m’meiaaumwsymLLa::m'im‘ms'Nma”lummsmmﬂawmm
ladaiau mauumwi:]'-anWWﬂaulwmamaqmmmu,aﬂmmmmﬂaﬂlm naafe faefd
wmﬁamwmaaauaamauisﬂawnmnmsnwumaulwﬂwamawwmﬂnm W ASIINUARUT Y
druvesaussiiiiiesen vrsam‘nawuﬂau’un’i,unﬁfuwmamuiﬁﬂamn (s ’lummvwwmam
mmm‘smwmnwmmmmmmmmmwmﬂﬂmawm'Lﬂ mawumwmaulﬂﬁwauamﬂu
RBILAILE

2.2 msnsranaulniiale

m‘smamaulwﬁﬂm’lﬁ] (Electrocardiography : ECG) Lun150579m19n15unn &g s
wf’juwamﬂﬂn‘s'smlN"Lwﬁwaamhmaam‘ﬂ’mvmnmwuamamﬁuammm‘l,wﬁ’lmumlw“ﬁﬂ
vimmuumwuwmmwmaﬂ LLa”‘U‘u%ﬂ‘lﬂiE}LLE‘IN“U‘HT\)EJﬂ’]Wﬂ'JEIEJUﬂiﬂJVIEIEJﬂ’]EIUEJﬂi’Nﬂ’iU N3
mwmﬂumsmmqumauarﬂmalumaqmmuamuuqmamlﬂma'ﬂuiwmU (Non-
invasive) N150U#n ECGs smemmmmlmmauani']qma‘lmamsawuwmmuaﬂwﬂaﬂma
Lailef (Implantable loop recorder)

P‘lﬁ‘LﬂWﬁTWﬂ’i]ﬁ]uL‘Iﬂl‘m‘Uﬂ’l‘i’Jﬂi”UUﬂ’l’iu’ﬂWﬁﬂ%mWﬂﬁ] MU?ULLNH%G]MWWMLHWO’]?‘I
ﬂ’]iIWﬁ']l‘ﬁL"U“UuLLﬁuﬂIWﬁ’]‘l‘iL%‘Uu (Msaduin) veadiedeilouay LLUaIMLUuiﬂﬂau Nty
sﬂﬂauﬂ antdlunsindnsuarauadiausvesnisduseily LLﬁ“ENI‘U’Jﬂ‘UU’]ﬂLLav
Mwniwasiaaila nisusingsvesnudemelagiidatuile wasnansenuvessvite
aUnsmm’ﬂuﬂﬁmmum’imwmiaaﬂ's.,mumh (Pacemaker)

ECGs dulngjay mLuuﬂmwamnu%awsammaa’lumiwawuw WAND199Y

gufiunsivdnd 'Vlllﬂi]uﬁ'Wl5Uﬂ’]‘i’)uQﬂﬁiﬂ’l’mwﬂﬂﬂﬁl’ﬂax‘iﬂﬂﬂﬂiﬂLW?Jﬂ"Ii’J?JEJ



2.2.1 #aNN59N9U

auUnsal ECG ag mwwuav‘umaammmmnmimaauuﬂaﬂw%ﬂLanquumvsuw
Aatwilandaiderla depolarizes lu':vmfmﬂmmwuawﬂmLLmauﬁ'iq 'l,u‘uzumamaaf]
wadndunidewlaurasvadasiisy zyau AFunirdnenmiusy mwawm%amamu
n13 depolarlzatlon MmamﬂwsﬂiuaﬂﬂimaﬂwmLﬂuﬂuﬂmanﬁﬂauﬂiu%mﬂ Na' uay
Ca* Lﬂummq‘iwﬂa"tﬂ'[uwaammuimwﬂwuwmm ¢ mwmmuwaam‘lﬂLmauﬂsa Wiladi
ua‘umwmavummmwm‘uamau Depolarisation agaluszidsuseudon mes“wum
GE ﬂm’l,wmmuimmﬁtjaaluiwum Sinoatrial N5y maaanmumlwawu N’]‘UIVIUW
atrloventncular mnuummsnumeﬂﬂwﬂwsa Ventricle ﬂ‘i"‘LLaﬂaumaW%ﬂﬂmwﬁ]mUu
nmwmuwsaamauam °uaummul%lﬁ'}sUmwaawalw%mwaaamuwmu’lﬂmwm
v8917l9 ‘UG"\)"LLE'IFNNELUULE’fU‘WEJﬂ‘WQUU‘WUWEJMiEJU‘Uﬂ'iuﬂWU nsuansratuandliisiv
Jamzlavsiuvesilauay ﬁ]ﬂaau’lwumwLmnmmu‘uamammwﬂa

I@FJ‘Uﬂﬁlﬁ]”l‘ti‘ﬂ'ﬂﬂﬁﬂ&ﬂﬂﬂ’)’]ﬁm‘ti’lLLﬁuW?ﬂiJUﬁ’)ﬂﬂiﬂi?ﬂJﬂuLUUQ (Mo UL
18 (LA), Wruvan (RA), kasendne (LL) mlw%Wmam’ﬂmﬂtmummﬂa LA+RA, LA LL uay
RA+LL) t@1dnmanusiazaisunda dn (Lead) LLmﬁ”aﬂﬂ‘l{lWﬂﬁ]mﬂiJJJ‘VILLGlﬂG‘l’Nﬂu Uszianil
uANAeUYeY ECGs aunsniBenmudiuineasdniviinssusin i ECGs wuy 3. lead, 5-
lead, ¥58 12-lead ECG wuy 12-lead azifudin 12 dyaralniiuansdreduluglnian
Uszanadfennu LLauiJﬂi] g ldilumstuiinuuuhefaierhivihdrve sy lniimle
avi'lamuwau‘uummuaanunﬂummmsvmw 3-lead way 5-lead ECGs mmﬂuuwmlm
AaTUethereoay gnuanIUUIDNMYRIUNTAl Lwammﬂmwmwmammu’luivmw
mstavselutaeivhmsaudslusonaivia E]’H]T\]uﬂJ‘Viia@’?fﬂﬁ]”liJﬂJﬂ’]iUwV]ﬂE]EJ'Nm’J‘ﬂﬂ‘]
vasndulniwilauuy 3-lead w3e 5-lead wuaaﬂuaﬂnmﬁl%

2.2.2 8

A1 "8n" Tu ECG ¥liAnAuduaumn stwvu’munﬂumﬂmwaawm 2 Aafi
wanas audruauialy A1 "ia maaumﬂ’l,’m.waawmmalwwmmmlwﬁwnmmawwm
aaulnile dndhueuid uummUgﬂuwaamuléﬂumsmam "Fonaudne” [Wudidningm
(LLauﬁ’lﬁjLﬂLUﬁ) finrsasinuiedlndiuiiuande Tasuns 10 319 (lusnsnedi 2.0)
mawunJummmummaulwﬁwﬂﬁ] "12 §n"

Tudnvmnia 11 80" oravaneds NTAINTBUYDIAIIULANAIVBLTIFU LT
'svmwaaamlw"ﬁwLLauLUuaaw:Jm'swaWuuﬁmiﬂamiawwnﬂaulw%mh lnsunasdnazil
YoLaN1E LU A |" LUuLL‘smulv‘Iﬁﬁsuwnmlw“ﬂwLLmumma“mlw%wqumﬁ’lummm "30
" \Buusesiulvfihseninsuausnuazvrdie (ummmuumﬁmuw%umﬂwmawm’lu
vl mﬁlLUumuwamaaazgmmhﬂﬁwmﬂm'sﬁ'anﬂumawﬂw%aﬂ'uwm) Andlionun
12 ¥imdugluuvvesaduluihvile "12 3o

lunsnsatiudny M7 "Sanauyr” INAEVUNEEINISUNLTRERINER |, 11, uay I
hszi%ga“lwﬁwﬁﬁmagjﬁ’uuﬁuum



U 2.3 amuszneusumistesinsyminanisii ECG
(AN :
http://upload.wikimedia.org/wikipedia/commons/a/dd/Blausen_O339ﬁELectrocardiogra
m.png)

2.2.3 aunusra997 W

Falwitr 10 Hraegnldidiniu £CG 12-lead xUsznaudaeiantilific 7 Nognss
ﬂmama'lwaaLmumammuuﬂaﬂmaamaLﬂma (wanalusnsnad 2.1) ’Lumaﬂsmaa\wuma
My Imam‘suuﬂw’uauaumLmuamu’f,ﬂwummwaagma

A5 2.1 Lamansinet i Suthetadalngn

Unedadalvidin N153RINT WA
(luanigoumsn)
a L o &
RA ALYUTMMANELINATOTUN
o 1 =l L7 :J 1 L%
LA TusurdaRentuiinng RA wauuwsLse
A v é" 1 o E23
RL Nuwnansauorudng
al = v & o
il luapuienufag RL udluyidne
o ) e ' i = v v
Vi Tuidmsadlasend (Gewinedlased 4, 5) AUVNVBINTEYNIIIEN
Vs Tuiinsedlaseiia (sewiredlassdl 4, 5) MuiereInsEgnuthen
W 391 leads Vs and V.
Vg Tuiidemsedlaseitn (sewinedlasedt 5, 6) 'lul,m’mqﬂa'mlmnivm
nlansn
Vs BUIUDULENDNU Vy TukuISnUSAuntinee
Ve WUIUBULANDAU Vy ke Vs Tunuisnud




1 2 3 avR aVL aVF

i _a}{.w,.,. JL ~ T A
Vi Ve Vv, Vv
A, Ly :L _,L Lo

= ° ' Y v =i - )
FUN 2.4 uanwiumisvesdnnuniiues JUN 2.5 uansgunuurespduluiiala
Wla 12 &n

(i ;
http://upload.wikimedia.org/wikipedia/com mons/4/41/Precordial_leads_in_ECG.png)

2.2.4 AAunazdanaan

N15A1U308U84 ECG ml‘l.l'uaamil,mumaqwﬂwuamuﬂﬁuﬂaumaﬂau P, QRS
complex, T wave, uazU wave, FeunAugarunsnuiulalu 50 B 75% veq ECCs Wz
ssgnislaendu T wazedu P Inifididaindy LugIU (Baseline) vasnsuansmnluives
wla ( Electrocardmgram) d5U Segments WIS IUTILUY nmm’LmUumu"ummimmaa
v&indu T wardeuntnadu P fsesuay Segment 5¢1919AAY P uaz ORS complex il
f1417 (PR segment) 'lum'lwuawmwmﬂnm Baseline 1{wiailau Isoelectric line (fid 0
mv) LLavLmummmaﬂmasaunmmuwaam‘i'«aLualmmivLLalwaIanaﬂaﬁauanmaﬂaw
awmawmlﬂﬂwaa FCG agrslsfimu ’lum‘limLUuT,'m Baseline awnﬂﬂmaa (Wwu wala
YIniden) maaﬂaﬂw (1w nédunifemlame) Weifisuiu soelectric line \losnnsua
1NNV UTENI19994 TP waz PR mam’iwaqawmaawmm ST segment Unfiae
amqaa’lnaﬂu Isoelectric line stwwnuﬁa‘zmL’meﬂwaqmmaamn Depolarise 8t
st Fdlaifinssualuany ECG osinnistiuiin ECG a'm’i,wylulﬂuwmau 0 mV agitlwy
WIINAUY Baseline NILUANINITONGIVDY ST segment LLau’LumanaUﬂumwnmmaa
Baseline 3suamIN1sanaIved ST segment



P B2 ors ST ¢ wg_

Wave cnpiex  Segmert Wave

ww 2.6 Wan ECG Un#l
(‘wm http://apinyasomya.exteen. com/images/581px-EKG_Komplex_svg.png)

o | <
A9 2.2 LLamau9a1ve9may

1291081 AN95UIY JEEEN
RR ana1seninerauy R wiliuarady R sely; dnsnsduee | 0.6-12
interval | ¥alatasinunfiedszming 60 fis 100 bpm
AAUP | sEWInenns depolarization Unfiwasiilavieauy tinmes 80 ms
TR mdneziann SA node (fadeluslovesuuraiiad
wsenszaulmialawiu) s AV node (drurdsssuuAIUAY
T wesilafivssaunuduuurewile) ) A¥NITZLIN
vissuuwluSissuude sunanediuedy P vy ECG
PR PR interval gn¥aaingmisuduvesndy P LUglagminduas | 120 - 200 ms
interval | QRS complex. PR interval ﬁ::ﬁaunaWﬁLL‘Nﬂ‘izfﬁ:ﬂWﬁ’lW
TunsAuMI991n SA node Hu AV node Wnlulualases
A199Tade. nsIzaviu PR interval Wumsuseunmiinves
mMevhutidives AV node
PR PR segment \aurondy P 1$1fu QRS complex. LaNAas | 50 - 120 ms
segment LLNﬂs“éfu%%da’m AV node U8 Bundle of His sielud
bundle branches 31nufluss Purkinje fibers. ianssu
"LW'Wﬂuiulmﬁsmmuuhamw WesuAALIasaslUvhle
waqa’mmaaa, LLazuLLamaaﬂmt,ﬂu!,auu,uuuu ECG PR
interval \AEatamenatiaunn
QRS | QRS complex @x¥1ouUn1s depolarization veswalaosa s | 80 - 120 ms
complex mmaumaamaimm m'lwaammnauﬂmmuaaulwm
Luamaunwﬂwaquu et QRS complex Unfvslauad
Ivgnimau p
J-point wmaﬁﬁm‘ﬁ QRS complex éuqmuaz ST segment Sudu N/A

Sl InUinaneuswnviousinaves ST fusing




= 1 | o
197199 2.2(78) LERIU9I81U09RAFY
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A8 A8 U JYUHLIAN
ST ST segment iausia QRS complex Wnfumiu T ST segment | 80 - 120 ms
segment Lqu‘ﬁDquaﬂﬁ‘ﬁaﬁdNQﬂ depolarized sy isoelectric
PAUT | Al T ununns repolarization (M3en13AUM) vosilaties | 160 ms
819 F2sna19ngnuduYes QRS complex lUdsanvasniy
T gnisenintutisnatlinevaussauysal afwdwendy T
gnisenindutianalinevaussduius (Mietrananseuus)
ST | STinterval gn¥a91n J point fetatevesndy T 320 ms
interval
QT | QT interval gninangmi3udures QRS complex lUflsUate | 420 ms
interval | veAdY T. QT interval feniduifutiadoidosdmiunsidy
yailoviosansldasinane (Ventricular tachyarrhythmias)
QT | uazmsmedundu. uulsausnsnisidurasiilouay,
interval | dwudruiedasiundia fesnsns correction dmiuas
il 3eagluzu Qe
AU U | Al U gnafaluauuigiuininainmsg repolarization Y814
Uz ineilawesans Unddusslivuinveseduidn was
ﬂaauwnﬁ%siﬁﬂsqﬂgﬁaasgw fuamundu T aue uwavilvun
navlufimmadeaiuge dsfusingdaauinn asdoiresdu
asludadenludens ansuaadugsludonnionioy
ﬁiaulmaaﬁﬁmmﬁu
AAu ) | A, - -point %38 Osborn wave wawﬂngfmﬂuﬂau delta
V]:J'l‘l]ﬂﬂ&lﬂ'i’]ﬂgﬁlaﬁ]’lﬂ QRS viSauumdu R igoswunaidn
gnitnsandnduennisudlsavesanariifaneiignmgiisi
uluvSenzideniunaidemnn

R amplitude

l QRS duration

gﬂ N 2.7 uane5188z188av04 QRS complex warkanlunsynRanssuresiilososan
(flan - http://upload.wikimedia.ore/wikipedia/commons/8/8c/QRS _complex.png)
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2.3 msasandulniindranie

msmwnamLuamalWﬁnLwa’lma'm'sums’;uaamml,wurmﬁﬂmLLavwmmﬂﬂiﬂmq
naLile U?‘Vﬂa‘umEJmirmf:;ﬂﬂaulwﬁﬂnmmuaamn Bidud (Electromyography %38 EMG)
mwmsamiummmmmumw 38 NVC (Nerve conduction velocity) waznsidulaseas
(Strength duration curve)

2.3.1 mansadadyanalniingaie (Electromyography EMG)
msmﬂmmammmlwqﬁma'}mua LUuwmwnumme Auae [@ulszam
wagndnilotofudeidorilisedaty mmsmaawammmlwﬁmavaamuammmmam
n'sq,mumaaammananiﬂmmauﬂmam‘laﬂmmua msmwﬂaulwﬁ'mmmuawsa EMG
Lﬂumwﬂwiwmammﬁmmmlwﬁwwaiwmmauﬂiumma namuaimama iialdlunnsg
'ma]aau,awwmmmwmsamwmLnﬂ’uu’l,uLauﬂsumwmaﬂmmua "ﬁﬂﬂﬁ’]EﬁﬂUﬂ’l‘iﬁ]i?f\l
aulile wazedulnihaues WANAI WL UNABIAE Wasind il fanstadt 2. 3

al a w a4 v} )
M5 2.3 uansvdadndluihuavanuinnevaussosdygnaliauss il uay

nénile
winvodygy 1l AngluA(mv) AufimeuaYBI(Hz)
dueI(EEG) 0.001-0.10 0.02-100
Wila (ECG,EKG) 0.02-3.0 0.1-30
n&uile (EMG) 0.003-5.0 2-10,000

q‘ = o af s l:i A’
2.3.2 \asesliauazgunsaldmiunsinianiundiunile EMG
Lﬂ%ﬂﬁﬁaua~a~uﬂs:ﬁé’m%’umwm%ﬂﬁulw“ﬁﬂ EMG UsznaumismiiaSosuay
Budnlnsatufindayayiandn mmaammaﬂmmmaawﬂw%ﬂmmwumniawmaammm
UAYAILLARING
2.3.2.1 dédnlnsa

al,aﬂIVlmmamlﬂﬁm’lwmmumammaauiﬂﬁmmmua EMG tunvay
d09wia Ao m'l.ﬂﬁ']mm‘ummu LLavmlﬂﬁwawiwwﬂammmﬂ,Wﬂw T2l Sy
nuquumﬂummv@wmmanuauLUumuﬂaaam (Bipolar electrode) 8afinfiu dau

a o o LY o = at 5 1 [ a = a o [
swannsadmsutudindyaralwindu wlssendy 2 93 fe dianlnsauuuidy (Needle
o L2 2 o“ AJ df s =1 as o d' v r.'al‘ v
electrode) mn’humamlﬂlunmmuaLwauumnammm fnglviilenduiidelnonsald
dmivitadelsaniendadn way aLanImmLumwwmwua (Surface electrode) 1UuuHY
?J?lWﬁ']WTNU‘LJN’JMuGU‘iL’Jm‘mﬂ mﬂuam'l%wﬂﬁcymmlwﬁwnammamauammm']wuﬂ
WNYBINISUARITRINELLTe uaﬂmﬂuuml!ua'msumsuumnazy:ymlw“ﬁwmaLﬂsaumau
ATveIN s alseam (Nerve conduction velocity) SidnInsauvuiduiitesld
nuunleun Bidnlnsauuunnuiien (Single coaxial needle electrode #38 Concentric

W W @ Al o @ =] a

needle electrode) iindnwazAdiiudne(RlisUatedn Wuvasnuariiunuaislany
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(Wnafidvseneaun) uawuludoonuwedfuaedy Lwafmmélw%szmwaawm (30
uilsAodudy 8nyarpunuanlansy) fvuadnnd 1 fadwes venaintu Seisidninsaan
yiialuuuuassuny (Double coaxial needle n3a Bipolar needle electrode) F4l4an
lavgasuduasndlulududaen aLaﬂIm'm*numummaamammné‘tﬂﬁwaqamancu
Uszamlduaudn dnlddmiunsnamsseninnitldnsausss 5Ul 2.8

Bmw E'

i‘iJ‘V] 2.8 ﬁﬂ‘lﬂmuﬁ]E]\‘]BLﬁﬂimﬁﬂm’ﬁEWWiUUUWﬂﬁﬂJﬁqu EMG

A %iin 2 SEaRRfY D : wladunuutasen
B : wiialannau E : = vllafudnevatesiaunuiiien
C : yllauundnsagy F : vilalindneanodn 2

(A ; http://ams.kku.ac.th/aalearn/resource/edoc/esSd/emgdoc54.pdf)

2322 @nvensdygin (Amplifier)
Luaa%'mafymmlw%mmauﬂivmmavnmmua IUsunaiesuazauialyl
1N mauuwmmimuﬂummwsaLanmauﬂa Lwamwmwuamacytymlwﬁmwwﬂl@ Tl
vualawedmsulunisiasen muwmwummmaazymmwm umawmwaqwaum
ammuamaam‘mamﬂalwﬁﬂumuwm'sfmm WazaINITINTOIF Y Y0 ‘wsalmmamm
dyeadlihsunuiildldldonn

2.3.2.3 grunanuaziuiinug
d o b 24 2/ dy = { =i =
Luaw1ﬂazgm’|m1w=i\1fmﬂLauU'§ zALavnauLle niemdulniigi5u3
mmﬁﬁmauauaamawwm mamauwammmlw“ﬁ'mﬂﬁ'ah wagaNey (M5199 2.3) Fely

uam’[mammamamwuwnawuLLmunizmw (tracing) wis1zagvinlaadulnihAnasusig

Y

d

usiinazuanIiuIanwesadalaalay ( (nouaussieALAligY) waswudyyadss (ady
81813 oglugruanuiides) m‘lwwml,ﬂamaummmaamﬁamn‘uuuauaﬂmmL:Jaaa'mnm
dyalriuuaoesadalaalausmeanan uanmﬂuu’l‘uﬁwuummmmuumwaaaﬂm

[}

[

tUulWamauasﬂﬂWWLLavmLaawawmmwamaulﬂﬂﬂmaﬂma
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MHM

!
LB g,

. ES]
—t L {ﬁ —
_[o7q

gﬂﬁ 2.9 ﬁeqﬂnmﬁm‘%’aamsamﬂam_,ﬂpmlwﬁﬂ EMG
(fan - http://ams.kku.ac.th/aatearn/resource/edoc/esSd/emgdocSﬁl.pdf)

2.3.3 3515959290 EMG

s

ﬁ]mﬁﬂﬁﬁnﬂi’muauluﬁﬁﬁdauﬂaw ﬁwmmaummﬁwﬁma nénaiousiiad
AONN1SIRsgLaANDB0E Indentified néuileidonistn WINITEU ALNIzUATY LAYy
aﬂwmvmwmmﬁuamamLuauuq nsmw’lfzjmuuwnLLUUqunuau’Lﬂ Concentric needle
electrode funadudndanifodu lagdumanudaundnelundiidedulufivarouidlsy
wnme mndesnsialaeldsamniianna (Surface electrode) dinflenAnnsaiudLmlavag
wuamama dyad EMG wuumlm uaﬂwmuLﬂumsmmwmnammmua ilale

ﬂﬁ'}llL‘L!E)L‘lﬂﬁJEl‘NﬂUﬂ'l'iUuVlﬂf\]’]ﬂ‘U’]UUV]ﬂLL‘UUL‘U&J

23.4 dyuiuiiiauasnisuana
234.1 mamiwmsammmwmﬂnm nmmﬂa na1177 lunsesianaitadelsm
Fremdu EMG 1 unuanlﬂmaﬂimmzwwu Luaamﬂwmmmanﬂmmsﬂawwmm
Aauniniglundmiledngle LLav“lumsmqmmaulﬂﬁmummﬁammmwﬂUnm’lu 3
anmzfe
1. vasunaduvdovnzadoulmdidninee adulihivudinlesen
Insertional Activity
2. nupWn AFU W TLTN LA SN Spontaneous Activity
3. wnzoenusildnduile manamuawmmmaﬂ
2342 edulwihiidudinle Gen voluntary Activity #ann1siasigsianuinung
Hufiorsanain
1. pdulwih EMG Alddutusinluannslay Spontaneous Insertion ¥38
Voluntary
2. dnwaisvesrauliihiudusgals mﬂuuﬂwmsmmiaumw AN
(Amplitude) A31A99 (Duration) wiammswa%aammmﬂauﬁlmm Ly
\iu Phase Initial Deflection uagaud (Frequency) \Judu Nt
farsanSeuiieudnuuzaiu EMG Und
2.3.4.3 mmxﬁqmsmmuaﬂmnwﬁmsmmnﬂﬁuw§aﬁmmﬂm1wﬂﬂuuﬂa
saadalaalavuds nsHadesesnduluisudinesiedoszdaelvanmudesdn
denRInnEesuLlIseeadaladlay insizmsiadssilfansonsuanuiauniues
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aaulwilFoeensnag leyldBumuiinuniudadsiasanaduliilnsasden iy
lneAuiaunfuesndu EMG fiansanain

1. dyanuvila Spontaneous 13a Voluntary EMG

2. dyanas EMG dieiUSeuiiousu EMG Undluanmss

2.4 Tsandnaniloseuuse (ALS) Aoasls

A131 ALS 6831370 Amyotrophic Lateral Sclerosis vi3elsandaniegouuss dalsly
Tsrvesndunilalnense wiulsafifinneuRnunfveswaduszamuneds WEIEINAYN
Tinduidegounsufomnungaguszamieds 11AIUAN mmaammumaa’luhawaa
IGEGHEN Imwwaaﬂﬁvammmmmawuﬂaaq mmmnaamavmahﬂuwam LLﬁuLUEN"\]’]ﬂ
Iiﬂnmmuaaamm (ALS) L‘Uiﬂi@mnmwnﬂmmﬂﬂﬂmm wagUszamied Seiidesen
dnedraniladn Tsnvoaaadusravunmds (Motor neuron disease; MND) 3alsaiaag
Uszamiidrdado” Tulszwmanssaisniae ﬁﬂhﬂu'lwamaaiiﬂ 8-Ln-3n (Lou Gehrig
Disease) mmwai'sﬂmma‘unLUﬁuaawmaLammﬂu‘[mmuU A.A. 1930

2.4.1 mmmwaq‘[sﬂnﬁ'lmﬁaaiau (ALS)

Iuﬂ%wuaqlwswuwmwmm’lﬂmaaﬂuammmawqLﬂmmsl,aamimaaummu
dei Tsmnduifoseuunss (ALS) Wennuargmnladeneliinlsasuiu 1o nsidesy
U’]x‘lBEINVI’NW‘UﬁﬂiiﬁJ‘NENISJVﬁ’]ULLu‘UﬂWVI’II‘ML%aﬁUqu‘I'MU’] Adsilomadeuliinenda
UARADY uﬂ'«arﬂaw'1qaoLL';maawumiﬂumaumaaaﬁww L mwmuaq aslaventn 597
‘I/‘Ii'e]ﬂ’]imﬂL‘HaiﬂiﬁUTQ‘UUQNWﬂ?ﬂﬂi muamm’lwmaaﬂiuammm aammmswmuwmﬂﬂm
smnumawawummmaL’;am'ﬂ,mﬂmﬂwsLaauaanwaaLsuaa fuiflesnanuunneinney
a'mwawm'[wnwaaamiemfm lulnAsun3y (Mitochondria) §Aufinuni WAANNAFIY
wzawmlulmumswmummwm

Amymrophic Lateral Sclerosis (ALS)

Nerve Cell

1 Muscle

1 Affected
Nerve Cell

T Wasted
Muscle

U 2.10 mswFouiisusewing waduni fu wad ALS
(i - https://health.ucsd.edu/specialties/neuro/speciatty-programs/als-
clinic/Pages/patient-care.aspx)
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2.4.2 lasthefiflamainlsandaniiagounss (ALS)
%’amﬁluﬂ5“mﬂamﬂ‘ummﬁﬂiwwiumm 2: 100,000 Ay WHulsa ALS Tuusay
b mamaﬂmmmwm‘[iﬂamumw 60-65 T saulamafiazmwulsn ALS Tupueauni el
wnniluaueigiios (mamq‘lusﬂw 2.11) e luudanmuls ALS Imuaaﬂsumm 15
wineuwemds wagdszuinferay 90 vasfitae ALS sglildemanniafugnssy Feillenna
Lﬁmuaammmmﬂisﬂiusuaﬂwmu uaﬂmnuwiuwaﬂﬁwwaw‘lmwmmmﬂ UnAwail
Iamammmamim‘['ﬁﬂu‘tmmﬂmwawwau

Uit 2.11 wmai'sﬂﬂmmuaaautm ALS
(i ; h‘ctp /fwww.momypedia.com/file_manager/mmpd/life_up date/772 _4.jpg)
(fi - https://www.pinterest.com/pin/194851121352957989/)

2.4.3 mmmaumﬁﬁﬂLﬁuwaa‘liﬂnﬁﬂmﬁadamm (ALS) 1Juagsls

Liumuwﬂ:}m fomsnduifoseussvesile vy w1 wiawindsladreniiane u
L EmLmulwuumuamwv miletioveslals 4 ’uauawsawammm I P B R P R
‘UE]EJ Jutilagunn aﬂuqmmﬂ sty mmsnmmuaaaumwmaa'] LUumn‘uuwmulﬂ
¥ia 2 4 mJ'aammEmwmawm'snmmuaaaul,rmmquma’mmaaawmLmeu UaNaN
mm‘sﬂamLuaaauLLsaLLawawmmﬂammaammnunmmua mu‘suuma wmamﬁw
pmIINURIEATausnenede A unienu WA laidn wmmuauamm Audv nandutiuie
2IMTUAT ddn

fUawuremermuwnmdadusndrendmiiensedandouuss vildmilosing
Tnglamzaueusiunseiloinsdesiiunansiin mszlennswies uiiossneinisues
Tsa ALS adefulsedu vl ALS lutisiuldsunsitadedndulsady Tnevhlude
mmin'jumnﬁuﬁﬂfmmﬁmminﬁmﬁamauwuma’ammLLa.uﬁ‘u 9INsTutas uasilennis
'ﬁmnunmm,uaw‘bfﬂuﬂﬁwm NIINAUDDULTS aumaa‘iwa‘iwmm'5v1'14awaa'1amumqﬁmn
viemavtiies uazndraiiemnslaseunsasunseridodliintemhemela 'Luf]wuumluu
355nwlsn ALS Tevie wavsesay 50 V045178 ALS T,maLaaﬂﬁ]uLaamwmmnummi
TussegnanUszanu 2 U emmuesmsi@ePininiaanszuumeladumaiuasmsamdsly
Uoadu ileanannisddn
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2.4.4 m7Adadelsandunilasounss (ALS) vildagnils
losannlsa ALS iiulsaii3nunliivie n1s3dedelse ALS fummmé’ﬂﬂfgu,au
i}“maﬁﬂiuwﬂﬂﬂLLWWUE]’]EJ‘WTE?JL’IW’] Uiuﬂ’lw}l‘ﬂﬂ’l“ﬂmﬂiuﬁuﬂ’]iiﬂﬂ&l@’]ﬁﬂm‘i“ﬁﬂﬂi
NMINTIIINMBUaLNISAUAUM Ui TRnsiiuiy 4 ‘(Nﬂ"IiGI‘i’J%VI’NMBQUQUGIﬂ’}W“U’JEJ
atuayumsiladelsn ALS femsanadulssamuaznduniasendulnih wie EMG

2.4.5 Lualmum's'm‘«aaemLUuIsﬂLLaqmsﬂgummamqh
doldsunisitedeinduut nsguainwiiteuuulsedulsyaes wagligsla
ﬁﬁmmﬁmuauavﬂsaum? swelifUeliviewifaanmddadials dslusuianeraozd
3i’ﬁuum1ﬁﬂwﬂiﬂhﬂm‘uulmLmlaunu‘iiﬂmwyuuﬂwmwwmauq
’lu%wu Riluzole (Rilutek®) ffNLﬂusJ’muﬂan'sU’LuNn"riLme mwvaams
Aduvedlsa Iﬂaquﬂumsaumm'snammm \Duansdeuszamudianilsdsdomniun
WulvaziliiAnnsmeeoigad wardalifindngrumensideiuansiaslowy luns
Snwlsalauoaioamegngudug saensldafusad
uenmliannnisideds nMssnwmuulseaulsy gARINlaud Ayuiniionas
maaﬂum‘wlumwnu Ky m‘saaﬂmaamaamaammna N15v11A9nssLLaENI59in
manmidand i eduigeuss Lwa‘ﬂaqnumsauwmmwnmauwﬂamLualuléﬂfmm
UL LLayﬁaamsmsmmawa mssmjs.,mummil,t,avwnwau’l,mwmwa g Unefidem
wouslild viiewmidesifosnnduienseansaunsy ms’Lmﬂ‘saamama’lwumlﬂawa
dhevmelafithy Aazvilidaeueuldlimiles mmmwsmmwm‘uulé‘luivmwm
\feswanlsa ALS Wulsaliidensnwilsve uAfler Rt vzasnsvenefaveslse
Riluzole Iﬂaquﬂumsaummﬁﬂqmm emLUumﬁaﬂsxmmuwuommumﬂLﬁulU-’\Jz

Minnsmevenyad

Ui 2.12 1 Riluzol Wiuswraevedlsandrudoseunss ALS
(finn : http://www.vcharkam.com/up(oads/sites/6/2014/08/pi[ls_bottle_ALSNO.jpg)
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2.5 EPOC Headset

3Ul 2.13 EPOC Headset

(i - http://pnimg.net/w/articlesfattachments/O/Bdf/?1ac78<:a5l.jpg)

EPOC Headset h) gunsaldwIn Brain Computer Interface (BCI) ’UU@‘V]UW]L‘IHWGMU']
ERIENE R Imawmﬁ‘tumsmswwﬁmmmuavuam EEG mmazidengs Usenaudag
14 ynsudnynn 2 ynoneds dsdyaadlaeszuuldane

2.5.1 winwailidanld EPOC Headset Ao
2.5.1.1 Andsdgunsaline
2.5.1.2 Software Development Kit fin1sWamun SDK agrssaiilos uazidnlale
4
2.5.1.3 Cross Platform anunsawamnlusiunsuuy 0S Tafld
2.5.1.4 ATOUARUUBULYATBILASINITNANLA

2.6 Arduino Board Uno
2.6.1 Overview

Arduino 81471 (91-9-8-1d n30 919elu) (luvesalulasnoulnsiaod
MIEnNa AVR AfinrsWauiwuy Open Source ﬂanmuﬂmwwamawe
mu Hardware uag Software m‘uammaammumhﬂmwlmw rmuummmummum
Sudy mucﬂmwummmsnmmmmmem:u Wasouen IS WsonaulUsLATY

AU UDIUBSA Arduino 'lumsmaaﬂnimaiqu ﬂaﬁlﬂzmummmmmwa
aLanwsauﬂamﬂmauaﬂua’maumameww1 /O vasuesa v3aifienuasainaluise
\iendenuvesalasu (Shield) Usziny 719919 U XBee Shield, Music Shield, Relay
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Shield, Wireless Shield, GPRS Shield \fusu sniloustefuvesnuuuesa Arduino udTemy

TUsunsunmuIse
dm3uA1dn "Uno" munedie "wils" lun1wBendsu wasdeanissaaeliiy

Lﬂsawuwmiﬂwad Arduino 1.0 Tm® Uno wag version 1.0 ’«J“Ltlusuw‘l“ija’mad
dm3u Arduino fuduq Tuewian uaz Uno fauguaraaluynues USB board Arduino

A B - ]
U
DIGITAL (Pw~) K ¥

RS (2510 i
g‘d'ﬁ' 2.14 Arduino Board Uno

(i - http://docs-
europe.electrocomponents.com/webdocs/OeBb/OQ00?66b80e8ba2l.pdﬂ

Arduino Uno tJuuasalulasaoulvsaiaesivinaiuuuiiugiuees ATmega
328 FaUsynaudag
1. 14 digital Input/Output pins (6 pin @x1saldidu PWM output 16
6 analog inputs
16 MHz Ceramic Resonator lddwmsunsesanudliiiuueds
USB connection
NGV ERE LT
ICSP header (In-Circuit Serial Programming)
7. Junm reset
laguasa Arduino Uno mmnamaama"l,:uimﬂauTmmaa‘samamimalwmaa
ﬁmﬂmmlmmmsmamawmu USB cable #38 91¢l@a8 AC-DC adapter w3a n1sld

o LA woN

LL‘UG]LG]E]'E
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183A Arduino Uno ﬁ'ﬁmml,mnﬁmmﬂua%mﬁuqdauwﬁvﬁ Tnefl Uno lufle
14 FTDI USB-to-serial driver chip wael ATmega16U2 iduniulusunsuutag USB-to-
serial
Arduino Uno Revision 2 I ATmega8U2 ¥11#8wian firmware 81y USB
protocol fi3en91 DFU (Device Firmware Update) I@dey
Arduino Uno Revision 3 i featurelualquiinduungsd
1. 1.0 pinout: 1fixl SDA wag SCL (aglnaiu AREF pin) wazdn 2 pins Tny
fie 10REF 1Uu pin 7l4lunsideusiotu Shields audanduusasuitls
MNUasa dwdn 1 pin Fudedlidmiuldsutu AVR lueyias
2. 199 Reset ﬁﬁ‘ﬁu
3. 14 ATmega 16U2 unu 8U2

2.6.2 Power
Arduino Uno a@snsaidleusialas USB connector 3 910 Power Supply 3nA18uBN
1o Tnsundandsuazgnienlassululih
unadgIINAeuenasaNliaIn AC-to-DC adapter #3aaMNULUARES Tnosad
fiu 2.1 mm center-positive plug lUgwaudsunmasdng
vesaaansavielalugiussiu 6 §9 20 volts Suvdsdnefadands 7 V s1adana
Ui pin 5 v flussiuiiinndy 5v uasveinensesliiades witmnausssuiiAngandt 12 v ens
demalivesalasumnusousnniiuly warormvilivedademeld feiudisussuimnsa
fiuuesnfe 7 V s 12 V
1. VIN {0y input voltage 989ussn Arduino Taeldumasinganmeuen
2. 5V u output pin Aimuem 5 V 91nusda
3. 3v3 1¥u 3.3 volt supply fiad193uan regulator vuvuese wazlinszuals
gNeim 50 mA
4. GND 1{u groud pin
5. I0REF 1T pin 719 voltage reference fululasreulnsaiass iodenen

wssnulviushield MuBeausaiuvesa

2.6.3 Memory
ATmega328 finthea1iusn 32 KB (0.5 KB 19d15u Bootloader) wananiigdl
9N 2 KB dwiuU SRAM uaw 1 KB dm¥u EEPROM

2.6.4 Input and Output
Tuudas digtal pins 9 14 pins uuve$a Arduino Uno d1u15a.dule
V4 input kazoutput Tneasyieuiiugsdy 5 v wazlvinssuegedn 40 mA
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2.6.5 Herdudugiuiy

1. Serial: 0 (Rx) uaiz 1 (Tx) Todmsuu (R uavds (Tx) TTL serial data lm® pin of
ﬂuﬂm‘traamalﬂm corresponding pins 984 ATmega8U2 USB-to-TTL serial chip

2. External Interrupts: 2 and 3 pins mawmmmw%mwumﬂ'wﬁ
Fon interrupt Tudene, vevedunaras viowdsuuaseh

3. PWM: 3,5, 6,9, 10 uaz 11 T PWM output 8-bits

4. SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK) ‘L«Eﬁw%’wsaﬁ‘ums?«iammu SPI

5. LED 13 : 18 build-in LED fieusafiu digital pin 13 e pin dAdu HIGH
LEDgfn , usiile pin 10y LOW LED gy

6. TWI: A4 or SDA pin and A5 or SCL pin 1@ w¥un1sdeasdeuuy TWi (Two
wires Interface %38 12C)

7. AREF: ussAue 183 d1wiu analog input

8. Reset: l4luns reset lulasraulnsaiaad Imamlﬂaﬂﬂmanmwuﬂu reset 13
UU sheild Lwaﬂamuﬂweauuuaim

uasa Uno & 6 analog inputs Faust AO f1a A5 ulae pins Tinuazden 10 bits

2.6.6 Communication

Arduino Uno anmmﬁamsﬂmaummm Arduino mauﬁ] %38 Microcontroller
1% Tnedlulasaeulvsaiaesuuvesn &o ATmega328 av'lwmsaaamwuaunw UART TTL
(5V) wuaa'l,u pins 0 (RX) Wae 1 (T) uonaani ATmega328 459495V 12C uay SPI
Communication &7 ATmegal6U2 T\J“’meiﬁammuuaumumu USB LLavﬂ“UiﬁﬂgLUu
COM port Lailauluds Software vuRsuawes Inei 16U2 14 firmware USB com driver i
Bumsgiu Taslifesiings diver :mnansuen udegielsimuaisidonldlns inf vy
35UUU{URNNS Windows

2.6.7 Programming
Arduino Uno @11190359393un135lUsunsusie Arduino Software Tnganuisaldley
m’Lmuungummi Windows, Mac OS X ua¥ Linux

2.6.8 Yawuibinlifuasa Arduino Wuilley
2.6.7.1 Sesenswau mﬂuwmmwumu "meaummxmmummmu
26.7.2 il Community nuAuAisIfuRauTuse
2.6.7.3 Open Hardware villigldaunsavvesalusesenldnulivarsdu
2.6.7.4 sianladung
2.6.7.5 Cross Platform asaimulusunsuuy 0 Tafld
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g? DEFINITIVE
i _T ARDUINO

Ey

PINOUT DIAGRAM

& fhasluis o g pin domt
2
g

B 710 tepenting m_o
0 Turret demen
Cat 1o Sirebic The sute-reiet " ay Mo g
x ; e & =3 omiy
s . i 2]

s 4 S gt
e 02X 3 st B0 e 3 b

Hat Commiite
3

R s s T AT T TS [
4

51]1/1 2.15 Arduino Uno Pinout Diagram
(fu - http://www.pighixxx.com/PghXxXcnt/Arduino/Uno/ARDUINO ' V2.pdf)

2.7 wawmaslinsEuanse (DC Motor)

uawmeslwvnseuanss LUumawumaauwmmyamwm’luiimuammwnﬁmwmum
ﬂmamuwwmmu'[umumSUsum'mJLia‘Lﬂmummmmmamumaaam Healdiuannlulsany
anavngsy wulssnuved lssnudulelndioanss Iwmmaﬂaw wsolwduduridsly
mtuindeusalwiin sy 'Lumsﬂﬂmmmnuuamaﬂwﬁwmuuammqm-ﬁwﬂ gunsal
7149) wamamaﬂw%ﬂivLLameu,avwﬂﬂmwaﬂmsmmwamama‘%’lﬂﬂ'mi.,l,l,ammw

F1499)

2.7.1 uaweslninszuanss (DC Motor) anunsautseanidy 3 ¥daldun
2.7.1.1 waweiuuveunsuvieisunindidueines (Series Motor)
2.7.1.2 wowesiuvayru WS uniuviuemes (Shunt Motor)
2.7.1.3 uawailiuuunaumseaiseninrouUnsueimes (Compound Motor)

2.7.2 drudsenauvesuawmasiuiinssuans
uaLma*ﬂwﬁwnisLLamsqﬁdauUssnaUﬁe‘f’lﬁ’m 2 daugad]
2721 dwiiegiuiiviefidenianaes (Stator) Usznaugae
wWisunSelum (Frame Or Yoke)
Wsun3alen LﬂuTﬂNmauaﬂmﬂmmﬂumdmwauaummuman
fu'm'u:lmualﬂm’lﬁlwﬂiumsLLa.vEJﬂawu3vﬂa'uauq'lw,l.mmemamaﬂwaamamammu
vuhulugunseanssuen mgﬂw 2.16
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sUw 2.16 muwaaﬂuwmaammm
(e : http://202.129.59.73/tn/motor10-52/images/farm.gif)

2. fausimdn (Pol e) Usznaume 2 f’huﬁatmmzmzjmﬁnua.ﬂummm
AULINUALTA (Pole Core) mmmmumanmqq ﬂUﬂ’}EJﬂu’JUUSuﬂEJU
ﬂuLUmmwﬂmﬂnUwa muﬂmawmL'du*siﬂmuuLwaiﬂdiUiUﬂammmIiLmamEer
Susimdn (Po le Shoes) mmmﬂizaaﬂ’lmqmeanLLaviiLwaﬂnawmﬂumﬂwaﬂLwa'[.wmm“ﬁau
mmﬂuawaﬂ foxuwa'lmaumqLL:Jmanmnmuumaﬂmﬂ’uaLL:Jmanmulﬂmiimasmnmam
wm'i,w,ﬂmLﬁwmmamawmaﬂ‘smasmmLﬂum'sm'lwuat,mammawuu (Torque) miﬂw

27

'a'1J1q 2.17 wnuth
(fin : http://202.129.59.73/tn/motor10- -52/images/armature.jpg)

ﬁ’J‘UVIﬂEN VAR IAAUNULWEN (Field Coil) %”WU@EJ"S@U‘]LLT’M'H?LL&JLW%H
‘Uﬂa'}ﬂu‘ﬂ’lwuq%iﬂﬂi”LLﬁﬁ]’lﬂﬂ’lﬂU@ﬂLWBﬂ‘i'NLﬁULL'NLLQJL'WaﬂsLVNﬂﬂ?Ju LL'ﬂuLﬁULL'NLLEJmaﬂU
'ﬂuLﬂﬂﬂ?i‘HﬂﬂNLLauLa‘iﬁJﬂuﬂ‘U?l‘LJ’]ﬂJLLlJLWﬁﬂ‘U‘eNEJ"ILSJL'\]B'SV]']IWLHWLL?“\?UG]‘UU f’NEUVI 2.18
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Uit 2.18 vamnau i
(fian - http://202.129.59.73/tn/motorlO~52/images/pole.gif)

2.7.2.2 éviyu (Rotor)
mwuuman‘am"ﬁ,sma‘smwuuum’lmﬂmmmmuuLmu'maﬂ”lumauaﬂUu
(Ball Bearing) mﬂvnauaa’lmmﬂmmma (End Plate) vpsuailnes

‘a"lJ'V] 2.19 lsimes
(‘wm http://202.129.59.73/tn/motor10- -52/images/armature jpg)

Mlswesusznaunie 4 drumeii fe

1. ununal (Shaft) iumdwivdameudiommes uardaunuimdnodsan
1985 (Armature Croe) Us~ﬂauuJumI‘sLmasLmumemvmaaal'Uuu,‘usaLwamﬂﬂwuuaa
Tuwwnddbifinsduasitouls

2. UNUMANDI51Ne05 (Armature Core) A8 LELMENUI9DTU LY
(Laminated Sheet Steel) L{‘Juﬁﬁm%’uﬁummmm{mLﬂa%&?’iaa%'wl,tiaﬁm (Torque)

3. Aouduames (Commutator) ¥nmevesunieenwuuiiudusasatauiy
luf (mica) Auseninedvespauiamnes duuﬁ’ﬁwmﬂauﬁumma{ vedlsosdmsuldvane
e wawﬂmmmimmas MneuluamesisautuRnfuLnuNaT Jugunaunsanssuen 3
wmmamanmmwmu (Carbon Brushes) ifiSunszuaainaretoudluds YAAINDITUN
Lﬂaﬂwaaﬂuﬁul,mt,mmanEJnmuwud‘lmﬂmn'1's'vrﬂamgayt.a'suﬂunmawmu,umanana:m
FuinaInvaalIndInaivan AINa1NILaUTeNI1UfATemeIne3 (Motor action)
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4. YAAINDITUILDS (Armature Winding) LUU‘UWﬁ'JﬂWUEJEIIUiENﬁﬁBW
(Slot) veaunueIsULIDS muwamaqmmuLaﬂmaiwmLLavmmma‘ua}vmﬂmauaaumuaa
ﬂ'urm‘aammwmm‘[smawumuuf] LWEWHJWIWLHQJ'NﬁMﬂUQ'IUﬁ]N“]

2.7.3 wanmsvesamasnszudlniinse (Motor Action)

vannsvesuawmeilwinssuanss Weduussiunsrualwiinsad iU lunomes
drunileay LLUNmumumaummeaimlﬂiwmmmm'smmasamamumeaﬂw uay
nszualwindndrumnileazivadilulurnainaunuuivgn (Field coil) a¥1atamilo-183y ax
Wnsuwivan 2 au luvasdonty suauandiveaduuse windn svlidnfufie
99599 EHN A9 Ay anafeaziasuLsiy vlddaussdalusiedunoes culd’m
WNUNAILATLAULNATE muaaﬂumauaﬂﬂumawamas m‘lwmimmaiwuulm YU Tic
amnLaasmwmwmulmuwamw 151993 (Rotor) mwmamﬂmwmwu Mg duLSs
meanmaamﬂgnsmmaﬂu iliunainesuniees mai‘sLmawuulﬂuuLUuwmema
yaaaudi (Fleming’left hand rule)

2.7.3.1 woweshiihnszuwanssuuueynsy (Series Motor)

uamas‘lWﬁwnsuLLaqumuauﬂsu ﬂauaLmaswma‘uﬂamammmmanaunsu
fuansiaesveseinaiuilniiin d3amas (Series Field) :Jﬂmanwmmma‘tmawmaauaul%
L‘UumumawaamlﬂﬂwmaﬂmmLﬂsu‘lw%mw:Jm‘iau’uamamasauﬂsmualmiwarﬂ
AT gunuaillnanuida AuEafasanaiainlvan Wanuinusevinaruniin
AINUL3I8AAY WATAAIATaNBLAD Sl Lﬂuaumwsmﬂﬂmauumu%wwmm’lwu
in3eald iyt unareede Wy memmﬂu \3eeHaND1Ms Ul dnsutuates
e Matﬁla‘iﬂ‘iuLLﬁﬁ]‘Sx‘]LLUU@Uﬂ‘S&JI‘EN’}UHUﬂ lmmma‘lwmwunmmmmmnmmL':'n'am].,
amamalmuiwammmamﬂminuaamﬂma Aasunsgldsaiy weSuanfnuamasuuy
aynsuiwiesdilvanuongiane

o

Serie Arm.

S‘UVI 2.20 N%ﬂﬁmmwmuﬂmaﬂwqﬁ’lﬂi“m'mmuauﬂ'm
(7 - http://202.129.59.73/tn/motor10-52/images/Series-Motor.jpg)
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2

2.7.3.2 uowaslWinszuansawuuvuiy (Shunt Motor)
wawaslWinssuanswuuILIY vioSundiduy uatma'ﬁ'uamas’mu‘umuﬁ
YARIMAUNLLNENIEAD (Field Coi ) %wawuﬂuﬂuwmmﬂ “UFJE)']LEJLQ’EJ'S R 0]
mmanwmvummmmw LLiaumLiwuum LLG]?‘!’MEJL‘i’]i@UﬂﬁVIﬂu*ﬂu@Lm@iﬁ’mM’lﬂL‘ViJJ’l“‘ﬂ‘U
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TestBench™

Resabtime display of the Emotiv head set dat stream, includ ing EECG contact quality, FFT,gyio (f itted - custom
option), wireless packet acuis tionvloss display, marker events, headset battery level,

Record and replay files in binary EBGLAB format. Command fine file converter included to produce sy formt,
Define and insert timed markersinto the data stream, inchuding G- sceen buttons and defined serial port event s,

Markers are stored inEEG data file. Markes deéfinitiors canbe saved and relbaded Markers sre display edd inreal time
and playbsack modes

o Chaneat fpacrg

T o raglet.dhe

-

Highs ®hia fustne

e D‘ﬁ_n-\-‘n T

-
£

EEG display:
-5 second oHing time window [Chart recomder mode)

ALL or sdected channgs can be displayed
-Automitic or man ual scaling (ndividual ¢ han nel d is play mede )
-Adjustable channd offset (multischaone! display model
=Synchronized marker window

BRAN COMPUTER NTERFACE & SCIENTIFIC CONTEXTUAL £EG | EMOTIV 2014 | Page 5
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TestBench™

Gy display:
-5 second rolling time window Chart recader modes
Xand Y deflection

Data Packet disphiy:

=5 secandrolling graph of Packet Counter autput
Packetloss - irtegrated count of missing dats packets
Verify data integrity for wineless transmission fink

BRAN COMPUTER NTERFACE B SCIENTIFE CONTEXTUAL £EG [EMOTIV 2014 | Page &
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TestBench™

FFT display:

Selkected chan nel only

ALL or sdected channds ¢an be displayed
Adjustable ssmpling window stze lin samples)
Adjustable upd ate rate fin samples)

dBmade - power orampltude calcubitions

dBscale
FFTwindow methods: Hanning Harmming, Hann, Blackiman, Rectarigle
« Predefined and customsubiband histograrn disgplay - Delta, Thets, Alpha, Bets, custorn bands

Data Hecordingand Playback:

Fully adjustable sides, play/pause/exit controls
Subject and record 1D, date, start time recorded infile
naming convention.

BRAN COMPUTER NTERFACE & SCIENTIFIC CONTEXTUAL EEG | EMOTIV 2014 | Page 7
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Arduino Uno

- MADE

ARDUINO
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Product Overview

The Arduino Uno is & microcontrolier board basad on the ATmegad28 (datashest). It has 14 digital
inputioutput pins {of which 6 can be used as PWM outputs), 5 analog inputs, 3 18 MHz crystal osdillator, a
USB connedtion, a power jack, an ICSP header, and o reset button, It contains everything neaded to
support the microcontroller; simply connect it to & computer with a USB cable or power it with a AC-to-DC
adapter or battery to gt started. The Uno differs from all preceding boards in that it does not use the FTDI
USB-to-serigl driver chip. Instead, it features the AtmegaBU2 programmed as a USB-to-serigl converter

“Uno" means one in Halian and is named to mark the upcoming release of Arduino 1.0. The Uno and version
1.0 will be the reference versions of Ardune, moving forward. The Uno is the latest in a series of USB
Arduino boards, and the reference model for the Arduino platfonn, for a comparison with previous varsions,
see the in i

— -
Specifications Page 2
R . -
s e e o B
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Microoontrolier ATmegald2s
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (mits) 620V
Digital #O Pins 14 {of which § provide PWM output)
Analog Input Pins 6
DC Current per VO Pin 40 mA
BC Current for 3.3V Pin 50 mA
32 KB of which 0.5 KB used
Flash Memory okies by
SRAM 2KB
EEPROM 1KB

16 MHz

Clock Speed

RS radiospares Rrapionics @
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The Amduino Uno can ba powered via the USB connection or with an &xternal power supply. The power
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter
can be connected by plugging 8 2.1mm center-positive plug into the board's power jack Leads from g
battery can be inserted in the (3nd and Vin pin headers of the POWER connacior.

The board can operate on an extemal supply of 8 1o 20 volts. If supplied with less than 7V, however, the 5V
pin may supply kess than five volts and the board may be unstable, If using more than 12V, the voltage
regulator may overheat and damage the board, The recommended range is 7 to 12 volts,

The power pins are as follows:

*  VIN. The input voltage to the Arduino board when il's using an external power source (as opposed to
5 volts from the USB connection or other regulated power source). You can supply voltage through
this pin, or, if supplying voltage via the power jack, access i through this pin.

+ 5V, The regulated power supply used to power the microcontrolier and other components on the
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another
regulated 5V supply.

*  3V3.A 3.3 volt supply generated by the on-board regulator. Maximum curmnt draw is 50 mA

*  GND. Ground pins.

S Memory]|

The Atmega328 has 32 KB of flash memory for storing code {of which 0.5 KB is usad for the buotioader); It
has also 2 KB of SRAM and 1 KB of EEPROM (which can be mead and written with the EEPROM kbrary).

Input and OQutput

Each of the 14 digital pins on the Uno can be used as an input or output, using pinModel), distalWnite(), and
digtalRlead( functions. They operate at 5 volts. Each pin can provide of receive & maxinum of 40 mA and
has an internal pull-up resistor (disconneded by default) of 20-50 kOhms. In addition, some pins have
spedalized functions: {

* Serial: 0 (RX)and 1 (TX). Used fo receive (RX) and transmit (TX) TTL serial data. TThese pins are
conneded to the corresponding pins of the ATmega8U2 USB-10-TTL Senal chip

* Extemal Interrupts: 2 and 3. These pins can be configured to tngger an interrupton a low value, a
fising or falling edge, or a change in valie. Ses the attachiternupt() function for details.

+ PWM:3,5 6 9 10, and 11, Provide 8-bit PWM output with the analogWrite() function.

* SPI: 10 (88), 11 (MOSI), 12 (MIS0), 13 (SCK). Thase pins support SP1 communication, which,
although provided by the underlying hardware, is not cumently included in the Arduino language.

* LED: 13. There s a built-in LED conneded to digital pin 13. When the pin is HIGH value, the LED is
on, when the pin is LOW, ifs off

RS radiospares nrapionics ‘ﬁ
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The Uno has 6 analog inpuls, sach of which provide 10 bits of resolution {i.e. 1024 different values) By
default they measure from ground 1o 5 volts, though is & possible to change the upper end of their range
using the AREF pin and the anslogRefemnce() function. Additionally, some pins have specislized
functionality:

* PC: 4(SDA) and 5 (SCL). Support FC (TWI) communication using the Wits brary.
There are a couple of other pins on the board:
* AREF. Reference voltage for the analog inputs. Used with

analbgReferance().
* Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board,

Communication

The Arduino Uno has a number of facilities for communicating with a computer, another Arduing, or other
microcontroliers. The ATmega3d28 provides UART TTL (5V) serial communication, which is available on
digital pins 0 (RX) and 1 {TX}. An ATmegaBU2 on the board channels this serial communication over LJSB
and appears as a virtual gom port to software on the computer. The '8U2 fimware uses the standard use
COM drivers, and no extemal driver is needed. However, on Windows, an *inf file is required..

The Arduino software includes a serial monitar which allows simple textual data to be sent to and from the
Arduine board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connaction to the computer (but not for serial communication on pins O and 1).

A SoltwareSerial ibrary allows for serial communication on any of the Uno's digital pins.

The ATmegald2B also support 12C (TWI) and SPI communication. The Arduine software indudes a Wire
liorary to simplify use of the 12C bus, see the documentation for details. To use the SPI communication,
plaase see the ATmega328 datasheet

Programming

The Arduino Uno can be programmed with the Arduino software (download). Select “Arduino Uno wi
ATmegald 28" from the Tools > Board many {according to the microcontroller on your board). For delails,
see the reference and tutorials

The ATmegad28 on the Arduino Uno comes preburned with a bootibader that allows you to upload new code
to it without the use of an external hardware programmer. It communicates using the original STK500

protocol (reference, € header files)

You can also bypass the boolloader and program the microcontroller through the ICSP (In-Circuit Serial
Programming) beader, see these mstructions for details.,

The ATmegaBU2 firmware source code is avallable . The ATmegallU2 Is oaded with a DFU bootioader,
which can be activated by connecting the solder jumper on the back of the board (near the map of Haly) and
then resetting the BU2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac
08 X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer
{overwriting the DFU bootlbader).

B m; Radiospanes RADIONICS A
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Automatic {Software] Reset

Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a
way that allows it to be resel by software running on a conneded omputer. One of the hardware flow control
lines (DTR) of the ATmegaBU2 is conneded to the reset line of the ATmegad28 via & 100 nanofarad
capacitor. When this line is asserted (laken low), the reset line drops long enough to reset the chip. The
Arduino software uses this capability to allow you to upbad code by simply pressing the upload button in the
Arduing enviconment. This means that the bootlader can have a shorer timeoit, as the lowering of DTR
can be well-coordinated with the start of the upload

This setup has other implications. When the Uno is connected to either 4 omputer running Mac 0S8 X or
Linux, it resets each time a connection is made 1o it from software (va USB). For the following haff-second or
50, the bootloader is running on the Uno. While it is programmed to gnore malformed data (ie. anything
besides an upload of new code), it wil intercept the first few bytes of data sent to the board after a
connection is opened. If a sketch running on the board receives one-lime configuration or other data when it
first starts, make sure that the software with which it communicates wails a second after opening the
connection and before sending this data.

The Uno contains a trace that can be cut to disable the auto-reset, The pads on either side of the trace can
be soldered together to re-enable it It's labeled "RESET-EN". You may also be able to disable the auto-reset
by connecting 3 110 ohm resistor from 5V to the reset ine, see this forum thread fordetails.

USB Overcurrent Protection

The Arduine Uno has a resettable polyfuse that protects your computers USB ports from shorts ang
owercurent Although most computers provide their own Internal protection, the fuse provides an extra layer
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection
until the short or overload Is removed,

Physical Characteristics

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector
and power jack extending beyond the former dmension. Three screw holes allow the board to be attached to
a surface or case, Note that the distance between digital pins 7 and 8 is 180 mil (0.18"), not an even multiple
of the 100 mil spading of the other pins.

RS ~radiospares rapiomics A
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How to use Arduino

Arduino can sense the environment by receiving input from a variety of sensors and can affect its
surroundings by controlling ights, motors, and other actuators. The microcontroller on the board is
programmed using the i ' | (based on Wirng) and the Arduino
development environment (based on Processing). Arduino projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Frocessing, MaxMSP).

Arduino is a cross-platoform program. You'll have to follow different instructions for your personal
08. Check on the Arduine site for the latest instructions. httpAarduino. colen/GuideHomePage

Linux Install Windows Install Mac Install
Once you have downlbaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable,

Blink led

Now you're actually ready to “bum” your I ok | Aecuion 402 -
first program on the arduino board. To KM T e, . e
select “blink led”, the physical translation (=)o) [B][3][E 1] &2

of the well known programming “hello £l
world”, select ]

File>Sketchbook> T hiune a0
Arduino-0017>Examples> 0s e '
Digital>Blink (i (L eBanh PRI

Once you have your skecth you'll
see something very close to the
screenshot on the right

pws Ladloo e el il BIUR ¢ EhE %
Jaer(ioeaiy

In Tools>Board select FoER A fo

S (G0 B ok

Now you have to go to
Tools>SerialPort

and select the right serial port, the
one arduino is attached to,

° Done compiling. |

Press Compile button v Oy £
{to check for errors) uploac A KA Blinking Led!

RS ~radiospares raviomcs ,g
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Dimensioned Drawing
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Terms & Conditi

1. Warnanties

11 The producar warants that s paducts wil conform % $w Specfostions This warranty lasts o one {1 yeans Yom fie dee of e sale. The
prodice sl not be Babla for any 08Nt T 416 CRUBE Dy Negiet FisURe of mistesinent by e Customee induding improper netslason o lesing

o £or dny prOGIC Dt e boen aired or madded nany way by 3Customer Somover Tha produsar shal nee te Htie Sor any defacts et resul fom
Cussormer's desgn specfioasons arinssucsons fr such produess Tastng wd ofwr qualty Convo MOrNIGRE B9 U8ed 10 the et Te Pruticer deans

NSy

12 ary products f o ook B Drawarenty e forth v, S pIOCers sclelisilty shel Beto reptace such poduts Thepoducers babity
SN Dl e o products That @re deemaned by B produesr Aot o contom sushwarranty ¥ 510 producer aincts 1 repiaos seh producss he
PmMICH sl have 3 ressonatle SMe Y rapRCHTENts Repiaced oroducts 3Bl De waraniad for 3 new ful warminty pedod

13 EXCEPTAS BET FORTH ABOVE PRODUCTS ARE PROVIDED "AS 18" AND "WITHALL FAULTS “THE PRODUCER DISCLAMS ALL OTHER
WARRANTIES. EXPRESS OR IMPLED REGARDING PROCUCTS INCLUDING BUT MOT LMITED T ANY MPLIED WARBANTIES 08
MERCHANTABUTY OR FITNESS FOR A PARTICULAR BURPOSE

14 Cussoner agrees hat prior 8 using any & stlems 1 Houde he producer produces. Cusiomer will 398t such systarms e the Snciondity of ha
PROGICH % Usidin such systams Thi (roducer may pavide Sechrics HOHCEO S O Seegn AGoR gty chareserionsan ety datsor o
wanions Customar ackrowledgrs and agrees e provdng Sase seres SUE POt S0M O RINeWI S I3 e rodunne s WarsirR e as s Sk
wtove vl noaddtonal colQelont of Jabiites shal aee o e PORAT (FOAING $UC S0NI088

14 The Acduno™ products are nof sutokzed for use in safa -l plaatons whem & faum of he pogc waodd TEARNAY DB SpRcIed 10 Calne
#avers parsonal injury of death Sefety-Cical Apchoaons include. without kmitasan, 1 suoport devioss and SIS squpmant oF SysNems for ha
OpamION of MCkEr OIS I MEDONS SYENE Aduno ™ produss aanete designan oo niended &y u SR MBIy OF S00I0N0H SPDICETONS oF
SrdrnmaTEs and far automatve Spplicitons of envormant Custamer acoowedges 4rd agrees hatany such we of Aduno™ pmducts which s solaly
e Customad's gk, snd that Customer s suiaty Ssgonsitie or oOMEhaNoR Wit o a0 vl MQUITTDTY TEQUrETMAIES in onnecton Wity such use

18 Customer schknowBdges av sgrots Tt s solaly responsitie for Sarplance Wit all mgal reguiaiony and sakeycalatd reduranenss RN i
Piodatis and iy wbe of Ardiing ' piaducts o O % MY OMIaENG My KOG E S InYrmagon or BREOO that iay be
pmvided by e pmducm

L. Indemnification

Tha Customer scknowladons 8nd agmes todetend. indemnty 10 hoid narmiess the producsr ko and AgaNSt Ay andal third- Ay oSS, Jamages
Gabites and eapanses it incu ¥ e et drady csed by (] 80 sttual reachbya G e g o and wiraotes made unde he
srrvs v condtors o i) $1e U ssnagigenca of wilkl misoonas by i Customer

3 Consequential Damages Walver

13 Svant Sie produces sl e b 1 e Customer or &y $ind pates by Ay specal ool Indmct Dt ncdetsl oorseguantal or
warnpiary JaMAGEs N oorveclon with or g out of $ie pmducts D Reraurnder regarchuss of whaolfer the producnr as bedd advsed of the
pessblity af such damages T secton wif sortve f0 Srninason of e waranty parod

4. Changes to specifications

Thpoduts may rmake cangss  specismons and irodust BEHCHPENS o iy Brie withou AON08 The Cussomes mustno #ly o 18 BOB6I0R oF
haraciasics of SNy BSaLRL O Inetuchons Mixked s ved” o Undefnad * Tha sroducer ceserves (hese G S8us defrisen sl have o
Tapan Uity whig soover Ko oordicls oF iIncompa bilses wising Som Gikra tanges W han The productvfomason on he Web Ste o Makeias is
ubject 1 changewithout mofos Do nce S0alze 4 dengr with $i8 inketnason

Enviromental Policies

The producer of Arduino™ has joined the Impatto Zero®
policy of LifeGate.it For each Arduino board produced is
created / looked after half squared Km of Costa Rica's
forest's,
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1An

Thansiunfeunained
const int in1Pin = 5;
const int in2Pin = 6;
const int in3Pin = 9;

const int indPin = 10;

U L

void setup()

{
Serial.begin(9600);
pinMode(in1Pin, OUTPUT);
pinMode(in2Pin, OUTPUT);
pinMode(in3Pin, OUTPUT);

pinMode(indPin, OUTPUT);

LTI I LT T I 11111111 711101171111111071 17

void loop()
{
if ( Serial.available()) {
char ch = Serial.read();
if (ch =="'w)
{
Serial.println("Forward");

analogWrite(in1Pin,246);
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analogWrite(in2Pin,0);
analogWrite(in3Pin,250);
analogWrite(indPin,0);
delay(500);
digitalWrite(in1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);

digitalWrite(indPin,LOW);

LTI L1111 11 1411711100700 40107111177

else if (chi== 'x)

{
Serial.println("Backward");
analogWrite(in1Pin,0);
analogWrite(in2Pin,246);
analogWrite(in3Pin,0);
analogWrite(indPin,250);
delay(500);
digitalWrite(in1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);

digitalWrite(indPin,LOW);

LTI D111 1111101000111 1100701000011 110 717

else if (ch =='q)
{



Serial.printin("Left Forward");
analogWrite(in1Pin,246);
analogWrite(in2Pin,0);
analogWrite(in3Pin,0);
analogWrite(indPin,0);
delay(500);
digitalWrite(in1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);
digitalWrite(in4Pin,LOW);

LTI DD T LT LTI 1111100111100 11401711

else if (ch == '¢')

{
Serial.println("Right Forward");
analogWrite(in1Pin,0);
analogWrite(in2Pin,0);
analogWrite(in3Pin,250);
analogWrite(indPin,0);
delay(500);
digitalWrite(in 1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);

digitalWrite(in4Pin,LOW);

LITTLTTITTTTITTIT DT T LT L1101 11111010 1010111111010
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else if (ch == '2)

{
Serial.print(n("Left Backward");
analogWrite(in1Pin,0);
analogWrite(in2Pin,246);
analogWrite(in3Pin,0);
analogWrite(in4Pin,0);
delay(500);
digitalWrite(in1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);
digitalWrite(in4Pin,LOW);

LTI LTI TT T TET AT T T 11111 L1111 011 11T

else ifi{ch =="¢

{
Serial.println("Right Backward");
analogWrite(in1Pin,0);
analogWrite(in2Pin,0);
analogWrite(in3Pin,0);
analogWrite(indPin,250);
delay(500);
digitalWrite(in 1Pin,LOW);
digitalWrite(in2Pin,LOW);
digitalWrite(in3Pin,LOW);

digitalWrite(indPin,LOW);



i

else

{
Serial.println("Stop Motor");
analogWrite(in1Pin,0);
analogWrite(in2Pin,0);
analogWrite(in3Pin,0);

analogWrite(in4Pin,0);
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1Aan15:Ua-Ua LED

const int ledPinl = 31;
const int ledPin2 = 32;
const int ledPin3 = 33;
const int ledPing = 34;
const int ledPin5 = 35;

const int ledPin6 = 36;

int poRed = 0;

int stGreenl = 1;
int stGreen2 = 1;
int stGreen3 = 1;

int poGreen = 0;

INEE = ¢

Y s
void setup()
{

Serial.begin(9600);

pinMode(ledPin1,OUTPUT);

pinMode(ledPin2,0UTPUT);

pinMode(ledPin3,0UTPUT);

pinMode(ledPind,OUTPUT);

pinMode(ledPin5,0UTPUT);



pinMode(ledPin6,0UTPUT);

LTI L1111 1001711 171171107010101111 17
void loop()

{

if ( Serial.available())
{
char ch = Serial.read();
if (ch =<"yr)
{
if(poRed == 0)(
digitalWrite(ledPin1,HIGH);
digitalWrite(ledPin2,LOW);
digitalWrite(ledPin3,LOW);
poRed++;

poGreen = 0,

else if(poRed == 1)
digitalWrite(ledPin1,LOW);
digitalWrite(ledPin2,HIGH);
digitalWrite(ledPin3,LOW);

poRed++;
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poGreen = 1;

else if(poRed == 2){
digitalWrite(ledPin1,LOW);
digitalWrite(ledPin2,LOW);
digitalWrite(ledPin3,HIGH);
poRed = 0;

poGreen = 2;

i

else if (ch == %)

{

Serial.println("Turn ON Device");

if(poGreen == 0){
digitalWrite(ledPing,stGreen1):
stGreenl = IstGreent;

}

else if(poGreen == 1)
digitalWrite(ledPin5,stGreen2);

stGreen2 = IstGreen2;
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else if(poGreen == 2)(
digitalWrite(ledPin6,stGreen3);

stGreen3 = IstGreen3;

L e
else
{
digitalWrite(ledPin1,LOW);
digitalWrite(ledPin2,LOW);
digitalWrite(ledPin3,LOW);
digitalWrite(ledPing,LOW);
digitalWrite(ledPin5,LOW);

digitalWrite(ledPiné,LOW);
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®

L293D
L293DD

PUSH-PULL FOUR CHANNEL DRIVER WITH DIODES

m S00mA QUTPUT CURRENT
PER CHANNEL

m 12A PEAK OUTPUT CURRENT (non repeti-
tive} PER CHANNEL

w ENABLE FACILITY

n OVERTEMPERATURE PROTECTION

m LOGICAL "0" INPUT VOLTAGE UP TO 15 V
(HIGH NOISE IMMUNITY)

m INTERNAL CLAMP DIODES

CAPABILITY

DESCRIPTION

The Device is a monolithic integrated high volt-
age, high current four channel dnver designed to
accept standard DTL o TTL logic levels and drive
inductive loads (such as relays solenoides, DC
and stepping motors) and switching power tran-
sistors.

To simplify use as two bridges each pair of chan-
nels is equi with an enable input A separate
supply input 1s provided for the logie, allowing op-
eration at a lower voltage and internal clamp di-
odes are included.

This device is suitable for use in switching appii-

hED

N

SO(12+¢4+4) Powerdip (12+2+2)
ORDERING NUMBERS:
L2530D 12830

The L263D is assembled in & 16 lead plastic
packaage which has 4 center pins connected to-
gether and used for heatsinking

The L283DD is assembled in a 20 lead surface
mount which has 8 center pins connected to-

cations al fraquencies up to 5 kHz. gether and used for heatsinking.
BLOCK DIAGRAM
Us OUTL DUT3 Uss
5% F " F Vg
INL € I3
ENABLE1 ¢ ENABLEZ
INZ & IN4
4,5.6.7
g8 ig 14.15,16.17
()
ns2.283p4-9¢ DHTZ DUT4

July 2003

W7
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ABSOLUTE MAXIMUM RATINGS

79

Symbol Parametor Value Unit
Vs Supply Voltage *® v
Vg Logic Supply Vaitage 36 ¥
Vi hput Voltage 7 ¥
Ve Enable Voltage 7 V
b Poak Oulput Current (100 us non repetitive) 1.2 A
Pay Total Power Dissipation at Tep = 80 °C 4 w
Tog T Sorage and Junction Temperature -~ 4010 150 0
PIN CONNECTIONS (Top view)
NS
ENABLE 1 1 Vss
ENRBLE 1 L] 1 > 20 [T uss wrr <l .
INPUT 1 CI4 2 19 [T INPUT 4
ouTPUT 1 LT 3 18 [T OUTPUT 4 oureur: {i3 QUTPUT 4
GND {T] 4 17 [T GHD
GND [
GND £ 5 16 [ GHD ¢ . .
GND {11 6 15 [T GND GND 5 GND
GND {13 7 14 {11 GND
QuTPUT 2 [T} 8 13 [T OUTPUT 3 outPuT2 fle OUTPUT 3
INPUT 2109 12 {13 INPUT 3
us 18 11 [T EnnBLE 2 wr A NPT 3
H92:. 29301 -82 ¥s 8 ENABLE 2
S.6878
SO(12+4+4) Powerdip(12+242)
THERMAL DATA
Symbol Dacription Dip S0 Unit
Revigns Thermal Resistance Junction-pins max e 14 “Ciw
R pans Thermal Resistance junction-amisent max 80 50 ) ‘CW
Ripipcam Tharmal Resistancs Junctioncase max 14 -
{" Wi 8sq. om on boand heatsnk
27 S7]




L2930 - L293DD
ELECTRICAL CHARACTERISTICS (for each channel Vs = 24 V., Ves =8V, Tam =25 °C, unless
otherwise specified)
Symbol Parameter Tost Conditions Min, | Typ. | Max. | Unit
Vs Supply Voltage (pin 10) Vag 36 v
Vg Logic Supply Voltage {pin 20} 4.5 38 v
Is Total Quisscent Supply Cument | V=L, la=0; V=M 2 & M
(pin 10} VieH: bwl; VewH 16 | 24 | ma
Van® | 4 mA
lag Total (uisscent Logic Supply Vizl, lo=0; Veu=H 44 50 mA
Current (pin 20} Vi=H: =0 Vpn=H 18 22 | mA
Ven ® L 18 24 mA
Ve, :g';m Low Voltage {pin 2, 8, 12, ~03 15 v
Vi nput High Voltage (pin 2, 4, | Vas 57TV 23 Vs W
12, 19 Ve » 7V 2.3 7 v
Ia Low Voitage nput Cument (pin | Ve =15V = 10 uA
2 9.12.19)
I ggg V:)zmgsg;mui Cumsrt (pin | 23V SVayd Ves 086 Y 0 100 A
Vet Enable Low Voltage ~ 03 15 v
(i 1, 11)
Vet | Enable High Voltags | Vaa <7V 23 Vis v
{pin 1, 11) Vgs > TV 23 7 v
lan Low Voltage Enabie Cumrent Vi =15V ~30 | - 100 HA
{pin 1. 11}
Bt Hgh Vollage Enatile Current 23V SV sVas~ 08V + 10 A
ipint, 11
Veewan | Source Output Saturation low~08A 14 18 v
Voltage (pios 3, 8, 13, 18)
Vet Sink Output Saturation Voltage | la=+ 084 1.2 18 v
{pins 3, 8, 13, 18
Ve Clamp Diode Fomward Voltage | 1o = 600nA 1.3 v
t Rise Time {*) 0.1100.8Vs 250 ns
1 Falt Time (*) J.8100.1Vs 250 ns
fon Tum-on Delay () 0.5 Vito 0.5 Vo 750 ns
o Tumeoff Delay (1) 85 Vito 08 Ve 200 ns
{*) Soa g 1
&7 a
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TRUTH TABLE (one channel)

Figure 1: Switching Times
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Enable {*)

Output
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{"} Redatve 10 1he considersd chunnel

Figure 2: Junction to ambient thermal resistance vs. area on board heatsink {8012 +4+4 package)
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L293D - L293DD

oM o i OUTLINE AND
mu | rve [ max | min | rve, | max MECHANICAL DATA
at | 081 0.020
8 |o8s 140 |o.0m 0055
b 050 0.020
b1 | o038 050 |o.015 0.020
D 200 0787 %
E 8.80 0.348 |)\<
@ 254 0.100 ]
@3 17.78 Q700
F 7.10 0.280
I 5.10 0.201
i 330 0130
Powerdip 16
F4 1.27 0050
- ==

I

AT

it O e O .0 .~ (B N

l! 8
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L293D - L293DD
DIM. i o OUTLINE AND
e | vve. | max | e | 1ve. [meax MECHANICAL DATA

A 2.35 265 | 0003 0104

Al 01 03 {0004 0.2

] .33 451 |03 4020

[+ 023 032 | 0000 0013

D 1248 13 0.456 0.512

E T4 76 |00 0289

8 127 .05

H 10 10.65 | 0.304 0419

h 025 0715 (oo 6030

L 04 127 |08 0.050

S020
K 0" {min )8 {(max )

1
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Informaion fumished is believed 10 be SCamate and relintie MMowews, STMEOSRErON:S §ssumes mmywihﬂmﬂ
dumammmmmbwmwdmsumagmmmmmw Fon B use No
wmmmmm«mﬁn STMeroniedmnics. Spacicat mnﬂummm
’ ¢ oo, rapiaces a¥ informistion previously suppled. STMiroslectonics products

W6 DO BUBOOZ e K Use 88 Al COMponents n PPON deVICEs OF Sysems WOl express wrillen spproval of STMiroslectronics
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